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Glosario inglés / español (términos bilingüe -//- PowerPoint 2013)
	GLOSARIO INGLÉS / ESPAÑOL (TÉRMINOS BILINGUE -//- PowerPoint 2013)

	Nº
	Command or instruction in English
	Comando o instrucción en Español

	1
	Accept All Changes to This Slide.
	Aceptar todos los cambios a esta diapositiva.

	2
	Accept Change.
	Aceptar cambio.

	3
	Add a section to your presentation.
	Añadir una sección a su presentación.

	4
	Adds a comment about the selection.
	Añade un comentario acerca de la selección.

	5
	Adds a shadow behind the selected text to help it stand out on the slide.
	Agrega una sombra detrás del texto seleccionado para ayudar a que se destaque en la diapositiva.

	6
	Adds an action to the selected object to specify what should happen when you click on it or hover over it with your mouse.
	Agrega una acción al objeto seleccionado para especificar lo que debe suceder cuando se hace clic en él o pasar sobre él con el ratón.

	7
	Adjust character spacing loose.
	Ajuste del espaciado entre caracteres sueltos.

	8
	Adjust character spacing to normal.
	Ajustar el espaciado de caracteres a la normalidad.

	9
	Adjust character spacing to tight.
	Ajustar el espaciado entre caracteres de apretado.

	10
	Adjust character spacing to very loose.
	Ajuste del espaciado entre caracteres o muy flojo.

	11
	Adjust character spacing to very tight.
	Ajustar el espaciado de caracteres a muy apretado.

	12
	Align Bottom
	Alinear abajo

	13
	Align Horizontal Center
	Alinear horizontalmente respecto al centro

	14
	Align Left
	Alinear a la izquierda

	15
	Align object bottom.
	Alinee la parte inferior del objeto.

	16
	Align object center.
	Alinear el centro del objeto.

	17
	Align object left.
	Alinear objeto izquierdo.

	18
	Align object middle.
	Alinear medio objeto.

	19
	Align object right.
	Alinear objeto correcto.

	20
	Align object to slide.
	Alinear objetos a deslizar.

	21
	Align object top.
	Alinear objeto superior.

	22
	Align Right
	Alinear a la derecha

	23
	Align text bottom.
	Alinee la parte inferior del texto.

	24
	Align text center (If text direction is not horizontal).
	Alinear centro de texto (si la dirección del texto no es horizontal).

	25
	Align text left (If text direction is not horizontal).
	Alinear texto a la izquierda (si la dirección del texto no es horizontal).

	26
	Align text middle.
	Alinear horizontalmente texto.

	27
	Align text right (If text direction is not horizontal).
	Alinear el texto a la derecha (si la dirección del texto no es horizontal).

	28
	Align text top.
	Alinee la parte superior del texto.

	29
	Align to Slide
	Alinear a la diapositiva

	30
	Align Top
	Alinear arriba

	31
	Align Vertical Center
	Alinear verticalmente respecto al centro

	32
	Aligns a paragraph to the center.
	Alinea el párrafo con el centro.

	33
	Aligns a paragraph to the left.
	Alinea un párrafo a la izquierda.

	34
	Aligns a paragraph to the right.
	Alinea un párrafo a la derecha.

	35
	Animation Painter - Like the animation of a particular object? You can apply that effect to other objects in your presentation. To get started: 1) Select the object with the animation you like 2) Click Animation Painter 3) Select something else to automatically apply the animation FYI: To apply the animation to multiple objects, double-click Animation Painter.
	Copiar animación - Al igual que la animación de un objeto en particular? Puede aplicar este efecto a otros objetos de la presentación. Para comenzar: 1) Seleccione el objeto con la animación que desea 2) Haga clic en Copiar animación 3) Seleccione otra cosa que aplicar automáticamente la animación FYI: Para aplicar la animación a varios objetos, haga doble clic en Copiar animación.

	36
	Applies an animation effect to the selected object.
	Aplica un efecto de animación al objeto seleccionado.

	37
	Applies or removes bold formatting.
	Aplica o quita el formato de negrita.

	38
	Applies or removes italic formatting.
	Aplica o quita el formato de cursiva.

	39
	Applies subscript formatting (automatic spacing).
	Aplica el formato de subíndice (espaciado automático).

	40
	Applies superscript formatting (automatic spacing).
	Aplica el formato de superíndice (espaciado automático).

	41
	AutoPreview - See how the animation will look as soon as you add it or change it.
	Previa automática - Vea cómo la animación se verá tan pronto como lo agregue o cambie.

	42
	Bring Forward
	Adelantar

	43
	Bring the selected object forward one level so that it's hidden behind fewer objects.
	Trae el objeto seleccionado un nivel hacia adelante de manera que está escondido detrás de un menor número de objetos.

	44
	Bring the selected object in front of all other objects.
	Trae el objeto seleccionado delante del resto de objetos.

	45
	Bring to Front
	Traer al frente

	46
	Broadcasts the open presentation to a remote audience using the PowerPoint web application.
	Emite la presentación abierta a un público remoto usando la aplicación web de PowerPoint.

	47
	Browse for Themes...
	Buscar temas ...

	48
	Builds a new presentation.
	Construye una nueva presentación.

	49
	Bullets and Numbering... - Bullets and Numbering... - Home > Paragraph > Bullets and Numbering...
	Numeración y viñetas ... - Numeración y viñetas ... - Inicio> Párrafo> Numeración y viñetas ...

	50
	Bullets and Numbering... - Numbering Settings... - Home > Paragraph > Bullets and Numbering...
	Numeración y viñetas ... - Ajustes de numeración ... - Inicio> Párrafo> Numeración y viñetas ...

	51
	Cascades the open document windows on the screen so that they overlap.
	Cascadas de las ventanas abiertas de documento en la pantalla para que se superpongan.

	52
	Change case to "Capitalize Each Word".
	Cambie caso "capitalizar cada palabra".

	53
	Change case to "lowercase".
	Cambiar caso a "minúscula".

	54
	Change case to "Sentence case".
	Cambie caso al "caso de la oración".

	55
	Change case to "tOGGLE cASE".
	Cambiar mayúsculas y minúsculas "alterne caso."

	56
	Change case to "UPPERCASE".
	Cambie caso a "MAYÚSCULAS".

	57
	Changes Text of element / Renames a focused item.
	Cambios Texto de elemento / Cambia el nombre de un elemento de centrado.

	58
	Changes the case of letters between sentence, lowercase, or uppercase.
	Cambia el caso de las cartas entre oración, minúsculas o mayúsculas.

	59
	Changes the layout of the selected slide.
	Cambia el diseño de la diapositiva seleccionada.

	60
	Changes to a variation of the selected transition. Variations let you change properties of a transition effect.
	Cambios a una variación de la transición seleccionada. Variaciones permiten cambiar las propiedades de un efecto de transición.

	61
	Checks the spelling of the text.
	Comprueba la ortografía del texto.

	62
	Clear Narration on Current Slide.
	Borrar Narración en la diapositiva actual.

	63
	Clear Narrations on All Slides.
	Las narraciones claras en todas las diapositivas.

	64
	Clear Timing on Current Slide.
	Borrar Momento en la diapositiva actual.

	65
	Clear Timings on All Slides.
	Los tiempos claros en todas las diapositivas.

	66
	Clears all the formatting from the selection, leaving only the plain text.
	Borra todo el formato de la selección, dejando sólo el texto sin formato.

	67
	Clears all the formatting from the selection, leaving only the plain text.
	Borra todo el formato de la selección, dejando sólo el texto sin formato.

	68
	Closes Master View and returns to edit the slide show.
	Cierra la vista maestra y vuelve a editar la presentación de diapositivas.

	69
	Closes the application.
	Cierra la aplicación.

	70
	Closes the current presentation.
	Cierra la presentación actual.

	71
	Collapse all sections in your presentation
	Contraer todas las secciones de la presentación

	72
	Collapses text below a heading.
	Contrae texto debajo de un encabezado.

	73
	Comments Pane - Show the Comments pane to view, add, and delete comments. Comments are not displayed during a slide show.
	Comentarios Pane - Mostrar el panel Comentarios para ver, añadir y eliminar comentarios. Los comentarios no se muestran durante una presentación de diapositivas.

	74
	Compares and combines another presentation with your current presentation.
	Compara y combina otra presentación con su presentación actual.

	75
	Converts text to a SmartArt graphic to visually communicate information.
	Convierte el texto en un gráfico SmartArt para comunicar visualmente la información.

	76
	Copies formatting only.
	Copias de formato único.

	77
	Copies selected object or text.
	Copias objeto o texto seleccionado.

	78
	Copy
	Copia

	79
	Creates a link to a Web page, a picture, an e-mail address, or a program.
	Crea un enlace a una página Web, una imagen, un mensaje de correo electrónico o un programa.

	80
	Custom Shows...
	Custom Tele ...

	81
	Custom Slide Size.
	Tamaño presentación personalizada.

	82
	Cuts the selection and puts it on the Clipboard.
	Corta la selección y la coloca en el portapapeles.

	83
	Cuts the selection and puts it on the Clipboard.
	Corta la selección y la coloca en el portapapeles.

	84
	Decrease Font Size
	Disminuir tamaño de fuente

	85
	Decreases the font size of the selected text.
	Disminuye el tamaño de fuente del texto seleccionado.

	86
	Delete All Comments and Ink in this Presentation.
	Eliminar todos los comentarios y la tinta en esta presentación.

	87
	Delete All Comments and Ink on this Slide.
	Eliminar todos los comentarios y la tinta en esta diapositiva.

	88
	Delete comment.
	Eliminar comentario.

	89
	Deletes one character to the right.
	Elimina un carácter a la derecha.

	90
	Deletes one word to the left.
	Elimina una palabra hacia la izquierda.

	91
	Deletes one word to the right.
	Elimina una palabra a la derecha.

	92
	Demotes a paragraph.
	Degrada el párrafo.

	93
	Design variants - Customize Colors...
	Variantes de diseño - Personalizar Colores ...

	94
	Design variants - Customize Fonts...
	Variantes de diseño - Personaliza Fuentes ...

	95
	Design variants - Reset Slide Theme Colors.
	Variantes de diseño - Restablecer Slide colores del tema.

	96
	Displays a list of available kinds of bullet points.
	Muestra una lista de los tipos disponibles de viñetas.

	97
	Displays drawing guides on screen.
	Muestra guías de dibujo en la pantalla.

	98
	Displays heading level 1.
	Muestra el nivel 1 se dirigían.

	99
	Displays More Emphasis Effects (Animation).
	Muestra más énfasis Efectos (Animación).

	100
	Displays more Emphasis Effects. (Advanced Animation)
	Muestra más Efectos de énfasis. (Avanzada de Animación)

	101
	Displays More Entrance Effects (Animation).
	Muestra Más Entradas Efectos (Animación).

	102
	Displays more Entrance Effects. (Advanced Animation)
	Muestra más efectos de entrada. (Avanzada de animación)

	103
	Displays More Exit Effects (Animation).
	Muestra más efectos de salida (Animación).

	104
	Displays more Exit Effects. (Advanced Animation)
	Muestra más Efectos de salida. (Avanzada de animación)

	105
	Displays More Motion Paths (Animation).
	Muestra más trayectorias del movimiento (animación).

	106
	Displays more Motion Paths. (Advanced Animation)
	Muestra más rutas de movimiento. (Avanzada de animación)

	107
	Displays OLE Action Verbs (Animation).
	Muestra OLE verbos de acción (animación).

	108
	Displays OLE Action Verbs. (Advanced Animation)
	Muestra OLE verbos de acción. (Advanced Animation)

	109
	Displays or hides the footer placeholders.
	Muestra u oculta los marcadores de posición de pie de página.

	110
	Displays or hides the grid.
	Muestra u oculta la cuadrícula.

	111
	Displays or hides the title placeholder.
	Muestra u oculta el marcador de posición del título.

	112
	Displays paste options.
	Muestra pegar opciones.

	113
	Displays play controls when you move the pointer over audio and video clips during the slide show.
	Muestra juegan los controles cuando se mueve el puntero sobre audio y clips de vídeo durante la presentación de diapositivas.

	114
	Displays the Animation Pane to create custom animations.
	Muestra el Panel de animación para crear animaciones personalizadas.

	115
	Displays the Columns dialog box to customize column widths.
	Muestra el cuadro de diálogo Columnas de personalizar ancho de las columnas.

	116
	Displays the Effect Options dialog box.
	Muestra el cuadro de diálogo Opciones de efectos.

	117
	Displays the Format Background dialog box.
	Muestra el cuadro de diálogo Formato de fondo.

	118
	Displays the Format Background task pane to fine-tune formatting for the background.
	Muestra el panel de tareas Fondo Formato para ajustar el formato del fondo.

	119
	Displays the Format Shape dialog box.
	Muestra el cuadro de diálogo Formato de forma.

	120
	Displays the full-screen slide show using Presenter View.
	Muestra la presentación de diapositivas en pantalla completa usando la vista del moderador.

	121
	Displays the Grid and Guides dialog box.
	Muestra el cuadro de diálogo Cuadrícula y guías.

	122
	Displays the line arrows dialog.
	Muestra el diálogo de flechas.

	123
	Displays the Notes Page to edit the speaker notes as they'll look when you print them out.
	Muestra la Página de notas para editar las notas del orador que se van a ver cuando las vaya a imprimir.

	124
	Displays the presentation as a slide show that fits within the window.
	Muestra la presentación como una presentación de diapositivas que encaja dentro de la ventana.

	125
	Displays the presentation in Normal view.
	Muestra la presentación en la vista Normal.

	126
	Displays the presentation in Slide Sorter view to easily rearrange slides.
	Muestra la presentación en vista Clasificador de diapositivas para reorganizar fácilmente las diapositivas.

	127
	Displays the reviewing pane when reviewing changes.
	Muestra el panel de revisión en la revisión de los cambios.

	128
	Displays the rulers, used to measure and line up objects in the document.
	Muestra los gobernantes, que se utiliza para medir y alinear objetos en el documento.

	129
	Displays the Zoom dialog box to specify the zoom level of the document.
	Muestra el cuadro de diálogo Zoom para especificar el nivel de zoom del documento.

	130
	Displays this presentation in black and white, and customize how the colors are translated into black and white.
	Muestra esta presentación en blanco y negro, y personalizar cómo los colores se convierten a blanco y negro.

	131
	Displays this presentation in full color.
	Muestra esta presentación a todo color.

	132
	Displays this presentation in grayscale, and customize how the colors are translated into grayscale.
	Muestra esta presentación en escala de grises, y personalizar cómo los colores se convierten a escala de grises.

	133
	Distribute Objects Horizontally
	Distribuir objetos horizontalmente

	134
	Distribute objects horizontally.
	Distribuir objetos horizontal.

	135
	Distribute Objects Vertically
	Distribuir objetos verticalmente

	136
	Distribute objects vertically.
	Distribución de objetos en posición vertical.

	137
	Draw table - Design your own table by drawing the cell, row and column borders yourself.You can even draw diagonal lines and cells within cells.
	Dibujar tabla - Diseña tu propia tabla dibujando las fronteras de celdas, filas y columnas yourself.You puede incluso dibujar líneas y celdas diagonales dentro de las células.

	138
	Draws a line through the middle of the selected text.
	Dibuja una línea por el medio del texto seleccionado.

	139
	Duplicate Selected Slides - Duplicate Selected Slides - Home > Slides > Duplicate Selected Slides
	Duplicar diapositivas seleccionadas- Inicio> Diapositivas> Duplicar diapositivas seleccionadas

	140
	Duplicates a marked object.
	Duplica el objeto marcado.

	141
	Duplicates a selected slide.
	Duplica una diapositiva seleccionada.

	142
	Edit photo album.
	Editar álbum de fotografías.

	143
	Edits and jumps between your slides in the Outline pane.
	Edita y salta entre las diapositivas en el panel Contorno.

	144
	Edits the Header or Footer of the document. The information in the Header or Footer will appear at the top or bottom of each printed page.
	Edita el encabezado o pie de página del documento. La información en el encabezado o pie de página aparecerá en la parte superior o inferior de cada página impresa.

	145
	Ends the presentation review, applying the current accept and reject decisions.
	Finaliza la revisión presentación, la aplicación de los actuales aceptar y rechazar las decisiones.

	146
	Expand all sections in your presentation.
	Expandir todas las secciones de la presentación.

	147
	Expands text below a heading.
	Expande texto debajo de un encabezado.

	148
	Extends a selection to the beginning of a word.
	Se extiende una selección al comienzo de una palabra.

	149
	Extends a selection to the end of a word.
	Se extiende una selección hasta el final de una palabra.

	150
	Eyedropper - Select a glow color by clicking on the screen. - Home > Drawing > Shape Effects > Glow > More Glow Colors > Eyedropper
	Cuentagotas - Seleccione un color de resplandor, haga clic en la pantalla. - Inicio> Dibujo> Forma Efectos> Brillo> Más Brillo Colores> Cuentagotas

	151
	Eyedropper - Select a text fill color by clicking on the screen. - Home > Font > Eyedropper
	Cuentagotas - Seleccione un color de relleno de texto haciendo clic en la pantalla. - Inicio> Fuente> Cuentagotas

	152
	File Export Dialog
	Archivo Exportar diálogo

	153
	File Info Dialog
	Información del archivo de diálogo

	154
	Flip objects horizontal.
	Voltear objetos horizontal.

	155
	Flip objects vertical.
	Voltear objetos vertical.

	156
	Group - Join objects together to move and format them as if they were a single object. - Home > Drawing > Arrange > Group
	Grupo - Únete objetos juntos para mover y dar formato a ellos como si fueran un único objeto. - Inicio> Dibujo> Organizar> Grupo

	157
	Groups shapes, pictures, and WordArt objects.
	Grupos formas, imágenes y objetos de WordArt.

	158
	Hides any graphics on the slide that are part of the background theme.
	Oculta los gráficos en la diapositiva que son parte del tema de fondo.

	159
	Hides or displays the Ribbon.
	Ocultar o mostrar la cinta de opciones.

	160
	Hides the current slide from the presentation.
	Oculta la diapositiva actual de la presentación.

	161
	Hyperlink... - Create a link in your document for quick access to webpages and files.Hyperlinks can also take you to places in your document.Tell me more - Insert > Links > Hyperlink...
	Hipervínculo ... - Crear un enlace en su documento para un rápido acceso a las páginas web y archivos.Hipervínculo  también te puede llevar a lugares en su documento.Más detalle al respecto - Insertar> Enlaces> Hipervínculo ...

	162
	Includes a separate box with the slide text on the notes page.
	Incluye una caja separada con el texto de las diapositivas en la página de notas.

	163
	Includes the date in the printed handouts or notes.
	Incluye la fecha en los folletos o billetes impresos.

	164
	Includes the page number in the printed handouts or notes.
	Incluye el número de página en los folletos o billetes impresos.

	165
	Increase Font Size
	Aumentar tamaño de fuente

	166
	Increases the font size of the selected text.
	Aumenta el tamaño de fuente del texto seleccionado.

	167
	Insert Audio on My PC - Insert audio from your computer or from other computers that you're connected to.
	Insertar audio en Mi PC - Insertar audio desde su ordenador o desde otros equipos que usted está conectado.

	168
	Insert Equation
	Inserte la ecuación

	169
	Insert Excel Spreadsheet.
	Insertar hoja de cálculo Excel.

	170
	Insert new photo album: Create a beautiful presentation for your favorite photo collection.
	Inserte el nuevo álbum de fotos: Crear una bella presentación de su colección de fotos favoritas.

	171
	Insert Office App... - View Additional Available Apps for Office.
	Insertar Oficina aplicación ... - Ver Disponible Aplicaciones adicionales para Office.

	172
	Insert Online Audio - Find and insert audio from a variety of online sources.
	Inserte Audio Online - Encuentra e insertar audio desde una variedad de fuentes en línea.

	173
	Insert Online Video - Find and insert videos from a variety of online sources.
	Insertar video en línea - Buscar e insertar videos desde una variedad de fuentes en línea.

	174
	Insert Record Audio.
	Inserte Grabar audio.

	175
	Insert Screen Clipping - Take a quick snapshot of part of the screen, and add it to your document.
	Inserte Recorte de pantalla - Tome un panorama general de la parte de la pantalla, y agregarlo al documento.

	176
	Insert slide Number - Number the slides in your presentation for easy reference.You can also add the slide number by clicking in a text box, then clicking Slide Number.
	Inserte Número de diapositivas - Número de las diapositivas de la presentación para facilitar reference.You también pueden agregar el número de diapositiva al hacer clic en un cuadro de texto, a continuación, haga clic en Número de diapositiva.

	177
	Insert table dialog.
	Inserte diálogo de la tabla.

	178
	Insert Video on My PC... - Insert videos from your computer or from other computers that you're connected to.
	Insertar vídeo en mi PC ... - Insertar vídeos desde tu ordenador o desde otros equipos que usted está conectado.

	179
	Inserts a chart to illustrate and compare data.
	Inserta un gráfico para ilustrar y comparar datos.

	180
	Inserts a new slide.
	Inserta una nueva diapositiva.

	181
	Inserts a picture from a file.
	Inserta una imagen desde un archivo.

	182
	Inserts a SmartArt graphic to visually communicate information.
	Inserta un gráfico SmartArt para comunicar visualmente la información.

	183
	Inserts a text box into the document, or adds text to the selected shape.
	Inserta un cuadro de texto en el documento, o agrega texto a la forma seleccionada.

	184
	Inserts an embedded object.
	Inserta un objeto incrustado.

	185
	Inserts characters that are not on your keyboard, such as copyright symbols, trademark symbols, paragraph marks, and Unicode characters.
	Inserta caracteres que no están en el teclado, como símbolos de copyright, símbolos de marcas comerciales, marcas de párrafo y caracteres Unicode.

	186
	Inserts Clip Art into the document to illustrate a specific concept.
	Inserta imágenes prediseñadas en el documento para ilustrar un concepto específico.

	187
	Inserts decorative text in your document.
	Inserta texto decorativo en el documento.

	188
	Inserts the current date or time into the current document.
	Inserta la fecha o la hora actuales en el documento actual.

	189
	Justifies a paragraph.
	Justifica un párrafo.

	190
	Language Preferences... - Set the editing, display, Help, and ScreenTip languages. The editing language enables language-specific features, including dictionaries, grammar-checking and sorting.
	Preferencias de idioma ... - Establece la edición, presentación, Ayuda y lenguajes de información en pantalla. El idioma de edición permite a características específicas del idioma, incluyendo diccionarios, gramática comprobación y clasificación.

	191
	Line Spacing Options... - Home > Paragraph > Line Spacing > Line Spacing Options...
	Opciones de interlineado ... - Inicio> Párrafo> Interlineado> Opciones de interlineado ...

	192
	Macros - See a list of macros you can work with.
	Macros - Ver una lista de macros que puede trabajar.

	193
	More character spacing options.
	Más opciones de espaciado de caracteres.

	194
	More Colors... - More Glow Colors... - Home > Drawing > Shape Effects > Glow > More Glow Colors > More Colors...
	Más colores ... - Más Brillo Colores ... - Inicio> Dibujo> Forma Efectos> Brillo> Más Brillo Colores> Más colores ...

	195
	More Font Colors
	Más colores de fuente

	196
	More Glow Colors - Home > Drawing > Shape Effects > Glow > More Glow Colors > More Glow Colors
	Más Brillo Colores - Inicio> Dibujo> Forma Efectos> Brillo> Más Brillo Colores> Más Brillo Colores

	197
	More rotation options.
	Más opciones de rotación.

	198
	More Text Alignment Options...
	Más Opciones de alineación de texto ...

	199
	More Text Direction Options...
	Más opciones de dirección del texto ...

	200
	Moves down one paragraph.
	Mueve un párrafo hacia abajo.

	201
	Moves one character to the left.
	Mueve un carácter a la izquierda.

	202
	Moves one character to the right.
	Mueve un carácter a la derecha.

	203
	Moves one line down.
	Mueve una línea hacia abajo.

	204
	Moves one line up.
	Mueve una línea hacia arriba.

	205
	Moves one word to the left.
	Mueve una palabra hacia la izquierda.

	206
	Moves one word to the right.
	Mueve una palabra a la derecha.

	207
	Moves selected paragraphs down.
	Mueve seleccionados párrafos más abajo.

	208
	Moves selected paragraphs up.
	Mueve seleccionados párrafos arriba.

	209
	Moves the current animation to play earlier.
	Mueve la animación actual para jugar antes.

	210
	Moves the current animation to play later.
	Mueve la animación actual para jugar más tarde.

	211
	Moves the splitters which separate the different sections of the window.
	Mueve los divisores que separan las diferentes secciones de la ventana.

	212
	Moves to a pane from another pane in the program window (counterclockwise direction).
	Se desplaza a un panel desde otro panel en la ventana del programa (sentido antihorario).

	213
	Moves to the beginning of a line.
	Se desplaza al principio de una línea.

	214
	Moves to the beginning of a text box.
	Se desplaza al comienzo de un cuadro de texto.

	215
	Moves to the end of a line.
	Se desplaza al final de una línea.

	216
	Moves to the end of a text box.
	Se desplaza al final de un cuadro de texto.

	217
	Moves to the next slide after a certain number of seconds.
	Se desplaza a la siguiente diapositiva después de un cierto número de segundos.

	218
	Moves to the next slide after a certain number of seconds.
	Se desplaza a la siguiente diapositiva después de un cierto número de segundos.

	219
	Moves to the next task pane from another pane in the program window (clockwise direction).
	Se desplaza al panel de tareas al lado del otro panel en la ventana del programa (en dirección a las agujas del reloj).

	220
	Moves to the next title or body text placeholder. If it is the last placeholder on a slide, this will insert a new slide with the same slide layout as the original slide.
	Se desplaza al siguiente título o el cuerpo del texto del marcador de posición. Si se trata del último marcador de posición en una diapositiva, esto va a insertar una nueva diapositiva con el mismo diseño de la diapositiva como la diapositiva original.

	221
	Moves up one paragraph.
	Mueve un párrafo hacia arriba.

	222
	Navigates to the next comment in the document.
	Se desplaza al siguiente comentario del documento.

	223
	Navigates to the next revision in the document so that you can accept or reject it.
	Navega hasta la próxima revisión en el documento para que pueda aceptarla o rechazarla.

	224
	Navigates to the previous comment in the document.
	Navega hasta el comentario anterior en el documento.

	225
	Navigates to the previous revision in the document so that you can accept or reject it.
	Se desplaza a la revisión anterior en el documento para que pueda aceptarla o rechazarla.

	226
	New File Dialog
	Nuevo diálogo de archivo

	227
	Next Slide
	Siguiente diapositiva

	228
	No shape outline color
	No forma de color de contorno

	229
	Notes
	Notas

	230
	Object – Regroup
	Objeto Reagruparse

	231
	Office Clipboard - See all the items you've copied to the Clipboard.
	Portapapeles de Office - Ver todos los artículos que has copiado en el portapapeles.

	232
	Office Presentation Service - Anyone using the link can see the slide show while you're presenting online. - Slide Show > Start Slide Show > Present Online > Office Presentation Service
	Oficina de Presentación Servicio - Cualquier persona que utilice el enlace se puede ver la presentación de diapositivas, mientras que usted está presentando en línea. - Presentación> Iniciar visionado> Presencia en línea> Oficina de Presentación Servicio

	233
	Open File
	Abrir archivo

	234
	Open the Selection Pane: See a list of all your objects. This makes it easier to select objects, change their order, or change their visibility.
	Abra el Panel de selección: Ver una lista de todos los objetos. Esto hace que sea más fácil para seleccionar objetos, cambiar su orden, o cambiar su visibilidad.

	235
	Opens a new window containing a view of the current document.
	Abre una nueva ventana que contiene una vista del documento actual.

	236
	Opens Handout Master view to change the design and layout of printed handouts.
	Abre la vista Patrón de documentos para cambiar el diseño y la distribución de folletos impresos.

	237
	Opens Notes Master view.
	Abre la vista Patrón de notas.

	238
	Opens paste special dialog box.
	Abre el cuadro de diálogo Pegado especial.

	239
	Opens Slide Master view to change the design and layout of the master slides.
	Abre la vista Patrón de diapositivas para cambiar el diseño y el diseño de las diapositivas patrón.

	240
	Opens the Find dialog box.
	Abre el cuadro de diálogo Buscar.

	241
	Opens the Font dialog box to change the formatting of characters.
	Abre el cuadro de diálogo Fuente para cambiar el formato de caracteres.

	242
	Opens the Font dialog box to change the formatting of characters.
	Abre el cuadro de diálogo Fuente para cambiar el formato de caracteres.

	243
	Opens the Help window.
	Abre la ventana de Ayuda.

	244
	Opens the look in list when opening or saving a documents.
	Abre la mirada en la lista al abrir o guardar un documento.

	245
	Opens the New Slide dialog.
	Abre el cuadro de diálogo Nueva diapositiva.

	246
	Opens the Replace dialog box.
	Abre el cuadro de diálogo Reemplazar.

	247
	Opens the Research Task Pane to search through reference materials.
	Abre el Panel de tareas de investigación para buscar a través de los materiales de referencia.

	248
	Opens visual basic editor.
	Abre editor de Visual Basic.

	249
	Options Dialog
	Cuadro de diálogo Opciones

	250
	Paragraph - Fine-tune the layout of the current paragraph, including spacing, indentation, and more.
	Párrafo - Afina la disposición del párrafo actual, incluyendo el espaciamiento, la sangría, y más.

	251
	Paste and keep source formatting.
	Pegar y conservar formato de origen.

	252
	Paste and keep text only.
	Pegue y mantener sólo texto.

	253
	Paste and use destination styles.
	Pegue y usar estilos de destino.

	254
	Paste and use destination theme.
	Pegue y utilizar el tema de destino.

	255
	Paste as picture.
	Pegar como imagen.

	256
	Pastes cut or copied object or text.
	Pega las cortadas u objeto o texto copiado.

	257
	Pastes formatting only.
	Pegar sólo formato.

	258
	Pauses on words or selected paragraphs for a quick translation.
	Hace una pausa en las palabras o párrafos seleccionados para una traducción rápida.

	259
	Plays back audio narrations and laser pointer gestures during slide show.
	Reproduce narraciones de audio y gestos puntero láser durante la presentación de diapositivas.

	260
	Plays back slide and animation timings during slide show.
	Reproduce diapositivas y animación tiempos durante la presentación de diapositivas.

	261
	Preserves the selected master so that it remains with the presentation even if it is not used.
	Preserva el maestro seleccionado de modo que permanezca con la presentación incluso si no se utiliza.

	262
	Preview Animations - Play the animations on this slide.
	Preview Animaciones - visualización de las animaciones en esta diapositiva.

	263
	Previews the transition for this slide.
	Vistas previas de la transición de esta diapositiva.

	264
	Previous Slide
	Diapositiva anterior

	265
	Print File Dialog
	De diálogo Imprimir archivo

	266
	Prints the current presentation.
	Imprime la presentación actual.

	267
	Promotes a paragraph.
	Promueve un párrafo.

	268
	Recently Used Shapes.
	Las formas usadas recientemente.

	269
	Redoes the last action.
	Rehace la última acción.

	270
	Regroup selected objects.
	Reagrupar objetos seleccionados.

	271
	Reject All Changes to the Presentation.
	Rechazar todos los cambios a la presentación.

	272
	Reject All Changes to This Slide.
	Rechazar todos los cambios a esta diapositiva.

	273
	Reject Change.
	Rechazar cambiar.

	274
	Remove a section from your presentation.
	Eliminar una sección de su presentación.

	275
	Remove all sections from your presentation.
	Retire todas las secciones de su presentación.

	276
	Rename a section in your presentation.
	Cambiar el nombre de una sección en su presentación.

	277
	Repeats the last Find action.
	Repite la última acción de Buscar.

	278
	Replace fonts dialog.
	Reemplace diálogo Fuentes.

	279
	Resets the position, size, and formatting of the slide placeholders to their default settings.
	Restablece la posición, el tamaño y formato de los marcadores de posición de diapositivas a su configuración predeterminada.

	280
	Reuse Slides.
	Volver a utilizar diapositivas.

	281
	Rotate objects left 90°.
	Girar objetos dejados 90 °.

	282
	Rotate objects right 90°.
	Gire los objetos a la derecha 90 °.

	283
	Save Current Theme...
	Guardar tema actual ...

	284
	Saves and sends the file.
	Guarda y envía el archivo.

	285
	Saves the file under a different name.
	Guarda el archivo con un nombre diferente.

	286
	Saves the file.
	Guarda el archivo.

	287
	Select Objects - Select objects including ink, shapes, and text areas. This is especially useful when working with objects that are behind the text.
	Seleccionar objetos Seleccionar objetos - incluyendo la tinta, las formas y áreas de texto. Esto es especialmente útil cuando se trabaja con objetos que se encuentran detrás del texto.

	288
	Selection Pane... - See a list of all your objects.This makes it easier to select objects, change their order, or change their visibility. - Home > Drawing > Arrange > Selection Pane...
	Panel de selección ... - Vea una lista de todos sus objects.This hace que sea más fácil para seleccionar objetos, cambiar su orden, o cambiar su visibilidad. - Inicio> Dibujo> Organizar> Panel de selección ...

	289
	Selects a sound to play during the transition between the previous slide and the current slide.
	Selecciona el sonido que se reproducirá durante la transición entre la diapositiva anterior y la diapositiva actual.

	290
	Selects all objects, slides or text.
	Selecciona todos los objetos, diapositivas o texto.

	291
	Selects one character to the left.
	Selecciona un carácter a la izquierda.

	292
	Selects one character to the right.
	Selecciona un carácter a la derecha.

	293
	Selects one line down.
	Selecciona una línea hacia abajo.

	294
	Selects one line up.
	Selecciona una línea hacia arriba.

	295
	Send back the selected object behind all other objects.
	Devolver el objeto seleccionado detrás de todos los demás objetos.

	296
	Send Backward
	Enviar atrás

	297
	Send the selected object back one level so that it's hidden behind more objects.
	Envía el objeto seleccionado un nivel hacia atrás de manera que está escondido detrás de varios objetos.

	298
	Send to Back
	Enviar al fondo

	299
	Set Proofing Language... - Choose the language of the selected text. We'll remember to use this language every time we check spelling and grammar.
	Establecer idioma de revisión ... - Elija el idioma del texto seleccionado. Vamos a recordar por esta lengua cada vez que comprobamos la ortografía y la gramática.

	300
	Sets a special effect that will be applied during the transition between the previous slide and the current slide.
	Establece un efecto especial que se aplicará durante la transición entre la diapositiva anterior y la diapositiva actual.

	301
	Sets an outline color.
	Establece un color de contorno.

	302
	Sets the elements to include in the slide master.
	Establece los elementos a incluir en el patrón de diapositivas.

	303
	Sets the time when an animation starts to play.
	Establece el tiempo en que una animación comienza a reproducirse.

	304
	Sets the transition between all slides in the presentation to be like the transition you have set up for the current slide.
	Define la transición entre todas las diapositivas de la presentación para ser como la transición que ha configurado para la diapositiva actual.

	305
	Sets Translation Language.
	Grupos de traducción de idiomas.

	306
	Sets up advanced options for the slide show, such as kiosk mode.
	Configura las opciones avanzadas para la presentación de diapositivas, como el modo de pantalla completa.

	307
	Shape effect 3-D bevel options.
	Forma de efecto opciones de bisel 3-D.

	308
	Shape effect 3-D preset options.
	Forma efecto opciones preestablecidas en 3-D.

	309
	Shape effect 3-D rotation options.
	Forma efecto opciones de rotación 3-D.

	310
	Shape effect glow options.
	Forma opciones Brillo efecto.

	311
	Shape effect reflection options.
	Forma opciones reflexión efecto.

	312
	Shape effect shadow options.
	Forma opciones de sombra de efectos.

	313
	Shape effect soft edges options.
	Forma efecto opciones bordes suaves.

	314
	Shape fill eyedropper - Pick a fill color by clicking within the app window. To pick a color outside of the app window, click and drag.
	Forma cuentagotas llenado - Elija un color de relleno, haga clic dentro de la ventana de la aplicación. Para elegir un color fuera de la ventana de la aplicación, haga clic y arrastre.

	315
	Shape fill gradients dialog.
	Relleno de forma gradientes de diálogo.

	316
	Shape fill none.
	Relleno de forma ninguna.

	317
	Shape fill option dialog.
	Forma de diálogo de opciones de relleno.

	318
	Shape fill picture.
	Forma imagen de relleno.

	319
	Shape fill texture dialog.
	Forma de diálogo textura de relleno.

	320
	Shape outline color dialog.
	Forma de diálogo de color de contorno.

	321
	Shape outline weight dialog
	Forma de diálogo peso contorno

	322
	Show Markup - Show comments and other annotations.
	Mostrar marcas - Mostrar los comentarios y otras anotaciones.

	323
	Slides from Outline.
	Diapositivas del esquema.

	324
	Specifies the length of a transition.
	Especifica la longitud de una transición.

	325
	Specifies the line numbering to use.
	Especifica la línea de numeración a utilizar.

	326
	Specifies the line spacing to use.
	Especifica el espaciado de línea a utilizar.

	327
	Splits text into one column.
	Divide el texto en una columna.

	328
	Splits text into three columns.
	Divide el texto en tres columnas.

	329
	Splits text into two columns.
	Divide el texto en dos columnas.

	330
	Start Recording from Beginning... - Record audio narrations, laser pointer gestures, and slide and animation timings for playback during your slide show. - Slide Show > Set Up > Record Slide Show > Start Recording from Beginning...
	Iniciar grabación de principio ... - narraciones grabar audio, gestos puntero láser y diapositivas y los intervalos de animación para la reproducción durante la presentación de diapositivas. - Presentación> Configuración> Grabar diapositivas> Iniciar grabación en principio ...

	331
	Start Recording from Current Slide... - Start Recording from Current Slide... - Slide Show > Set Up > Record Slide Show > Start Recording from Current Slide...
	Iniciar la grabación desde la diapositiva actual ... - Inicio de la grabación desde la diapositiva actual ... - Presentación> Configuración> Grabar diapositivas> Iniciar grabación en la diapositiva actual ...

	332
	Starts a full-screen slide show in which you can rehearse your presentation.
	Inicia una presentación de diapositivas en pantalla completa en la que se puede ensayar su presentación.

	333
	Starts the slide show from the current slide.
	Inicia la presentación de diapositivas desde la diapositiva actual.

	334
	Starts the slide show from the current slide.
	Inicia la presentación de diapositivas desde la diapositiva actual.

	335
	Starts the slide show from the first slide.
	Inicia la presentación desde la primera diapositiva.

	336
	Starts the slide show from the first slide.
	Inicia la presentación desde la primera diapositiva.

	337
	Suggests other words with a similar meaning to the word you have selected.
	Sugiere otras palabras con un significado similar a la palabra que ha seleccionado.

	338
	Suggests other words with a similar meaning to the word you have selected.
	Sugiere otras palabras con un significado similar a la palabra que ha seleccionado.

	339
	Switch Windows
	Cambiar ventanas

	340
	Switches between Slides and Outline tabs in the Outline and Slides pane in Normal view.
	Cambia entre diapositivas y fichas Esquema del Esquema y panel Diapositivas en la vista Normal.

	341
	Switches to a different currently open window.
	Cambia a una ventana abierta actualmente diferente.

	342
	Switches to the next PowerPoint Window
	Cambia a la siguiente ventana de PowerPoint

	343
	Switches to the previous PowerPoint Window
	Cambia a la ventana de PowerPoint anterior

	344
	Text direction: Horizontal.
	Dirección del texto: Horizontal.

	345
	Text direction: Rotate all text 270°.
	Dirección del texto: Gire todo el texto 270 °.

	346
	Text direction: Rotate all text 90°.
	Dirección del texto: Gire todas texto 90 °.

	347
	Text direction: Stacked.
	Dirección del texto: Stacked.

	348
	Tiles all open program windows side-by-side on the screen.
	Azulejos todas las ventanas abiertas lado a lado en la pantalla.

	349
	Translate Selected Text.
	Traducir el texto seleccionado.

	350
	Turn on alignment of selected objects.
	Encienda la alineación de los objetos seleccionados.

	351
	Underlines the selected text.
	Subraya el texto seleccionado.

	352
	Undoes the last action.
	Deshace la última acción.

	353
	Ungroup - Break the connection between grouped objects so that you can move them individually again. - Home > Drawing > Arrange > Ungroup
	Desagrupar - Romper la conexión entre los objetos agrupados de modo que usted puede moverlos individualmente de nuevo. - Inicio> Dibujo> Disposición> Desagrupar

	354
	Ungroups shapes, pictures, and WordArt objects.
	Formas Desagrupa, imágenes y objetos de WordArt.

	355
	View – Normal
	Ver Normal

	356
	View – Notes
	Ver Notas

	357
	View – Outline
	Ver Esquema

	358
	View – Reading
	Ver Lectura

	359
	View – SlideSorter
	Ver SlideSorter

	360
	Waits for a mouse click to move to the next slide.
	Espera a un clic del ratón para pasar a la siguiente diapositiva.

	361
	Zooms the presentation so that the slide fills the window.
	Acerca la presentación para que la diapositiva llena la ventana.
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